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Introduction
This manual is designed to teach traders to use RealTick and the electronic trading system designed by Townsend
Analytics, Ltd.  The manual should be used as a basic tutorial for RealTick traders.  We suggest that the manual be read
and the instructions for creating a trading page and setting trading defaults and parameters be done when the market is
closed.  When the market opens, you will be ready to place trades quickly and confidently.  The manual is organized in
four main sections.

Section I, Understanding TAL Trading Tools, is a short introduction to the full spectrum of computer software used in
electronic trading.  This introduction will help users understand how elements of the system fit together, and provide
useful knowledge in troubleshooting.

Section II, Market Monitoring for Traders, introduces RealTick, Townsend Analytics, Ltd.’s real-time market analysis
software.  RealTick’s modules (e.g. MarketMaker, Market Minder, Chart, MultiQuote) display the information you need to
monitor the market.  This brief introduction only covers a small number of RealTick studies and commands, those most
likely to be used by traders.  A more comprehensive RealTick Introduction and Tutorial is available on our website or in
the RealTick Help menu.

Section III, Trading Features, describes the order entry capabilities of RealTick.  RealTick provides seamless access to
market information, analytical tools, and instant trading.  This tutorial shows traders how to set up a RealTick page to
trade, track orders, and monitor positions and account balances.

Section IV, Exchanges, Parameters, and Regulations, describes the rules imposed by various trading regulations and
exchange choices (RealTick can connect you to Archipelago, Island, SOES and SelectNet for order entry of OTC stocks.
If you trade listed stocks, RealTick can link into Southwest Securities and ABN-AMRO.  You can post your orders to
these firms, and they will fill them at the exchanges).  All the available order entry parameters are described in detail.
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Understanding TAL Trading Tools
TAL Trading Tools refers to the servers that provide market data and order information as well as the client program that
provides visual representations of the data and an order entry interface.  RealTick is a client program. That is, it runs on a
local computer and receives data from other programs known as server programs. These server programs run on other
machines and connect to RealTick via a network or over the Internet. The TAL Trading Tools software suite includes
several server types, each of which provides a different kind of information. The Permission Server provides information
about who is allowed to use which modules of the software. TA_SRV, also known as the Price Server, provides real-time
price quotes. The News Server provides updating online news headlines and stories. Other servers provide information
about trades placed with electronic exchanges, position and account information, etc.

All users must have permission to use the various software components before they can run any TAL Trading Tools
software.  A Permission Server keeps track of all user names with their relevant passwords and permissions.  Your
permissions should reflect the modules of our software and types of data you want to monitor as well as the trading
routes you want to use, as determined by your contract.  The Permission Server recognizes which exchanges, programs,
and studies you requested and will provide only that data to only those studies and programs.  If you do not see data for
a number of symbols, you may not be permissioned to use data from the exchange that trades those instruments.  If you
suddenly lose one or more of your RealTick modules as options in your toolbar, you may have lost your permissions for
those modules. If you think your permissions have been inappropriately revoked, please contact your system
administrator.

Network installations generally have several copies of each important type of server running, and may divide servers of
the same type into server classes.  For example, a trading company may have ten copies of TA_SRV running to provide
all the traders with up-to-date price information. Among these copies of TA_SRV, some may be dedicated to providing
options prices, some to providing NASDAQ Level II quotes, and others to providing historical data. Similarly, there may
be several News Servers, not all of which offer news from the same vendors.

Users whose data comes from servers on a network can choose a default server class (Level II, historical, options) for
each server type (TA_SRV, NewsSRV). The default server will be used in all windows where no other server is specified.
You do not need to choose an individual server within a class – load balancing functions in the TAL Trading Tools suite
do this for you automatically.

In addition to choosing a default server, you can set individual studies and/or study types to collect data from a different
server class. For example, if you trade mainly on NASDAQ, you will probably set your default server to one that provides
NASDAQ data. If you also occasionally trade options, you can create a TurboOptions window and set it to receive data
from a server that provides options data.  Once you have set the server for one TurboOptions window, you can save it as
your default favorite.  All TurboOptions windows you create thereafter using the toolbar button will now be set to the
same server.  Setting a server for an individual study or favorite does not change the global default server setting.  For
more information on setting the server for an individual study, see the help chapter devoted to that type of study.  For
more information on Favorites, see the RealTick Features chapter of the help.
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Market Monitoring for Traders
Traders must have a firm understanding of RealTick before setting up their trading pages and entering orders.  RealTick is
a program created by Townsend Analytics, Ltd. which offers real-time market analysis to support your trading decisions.
This manual assumes a basic knowledge of Microsoft Windows.  If you are unfamiliar with mouse features such as
moving and sizing windows within Microsoft Windows, please refer to the instructions under Windows Operations
below.  Users who are familiar with Microsoft Windows can skip down to RealTick Concepts.

Windows Operations

� To size a RealTick window:
1. Move your mouse pointer over to a corner of the window.  The pointer will change to a double-arrow.
2. Click the left mouse button and drag the arrow to a new location.
3. Let go of the mouse button.

� To size a panel within a RealTick window:
1. Move the mouse pointer over to the panel-splitter bar.  The pointer will change to a split double-arrow.
2. Click the left mouse button and drag downward until all information is showing in the upper panel.
3. Let go of the mouse button.

� To size a column within a RealTick window:
1. Hold your mouse pointer over the column heading and move your mouse pointer to the right.  The pointer will

change to a double-arrow.
2. Click the left mouse button and drag the arrow to a new location.
3. Let go of the mouse button.

� To move a RealTick window:
1. Click on the title bar of the window.
2. Drag the window to a new location.
3. Let go of the mouse button.
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RealTick Concepts
The basic unit of the RealTick display is the page.  Each page is a parent window within which studies are stored and
displayed.  Most users design pages around themes, such as D-mark futures or high technology stocks.  You may create
and save as many pages as you wish, but only one page may be displayed at a time.  The open page can be easily
modified, and if you wish to close the page after modifying it, you will be asked if you want to save modifications.  Each
page has a name and, if you wish, a “Hot Key” for quick and easy recall.  You can move quickly from one page to another
using the Page Manager and the commands in the Page menu.

Pre-configured pages contain studies that have been designed and saved for you.  If you have pre-configured pages,
they will be automatically downloaded to your computer when you start RealTick for the first time. You can change the
symbols of the various pre-configured studies easily.  If you would like to change a pre-configured study significantly,
however, we recommend that you create another page and configure the study yourself.  Fixed-page versions of
RealTick provide only one page.  Fixed-page customers have a severely limited ability to modify the studies on that page.
Fixed-page users who would like to create more pages must license a full-featured version of RealTick.

Each page can contain several studies or child windows.  The studies are the charts, market minders, multiquote
windows, and other data displays that give you the information you need on a segment of the market.  They are called
child windows because they appear within the larger RealTick parent window.  Each child window has its own title bar,
and only one child window can be active within RealTick at one time (the data in all child windows, active and inactive,
updates in real time where appropriate).

When you create a new child window or study, you set its parameters in a Setup dialog box.  You can use the same
dialog box to modify the study after it has been created.  To access the Setup dialog box you can use the RealTick menu
bar.  The RealTick menu bar includes four standard menu commands (Page, Design, Window, and Help) and one
menu command for whichever study is active.  This study-specific menu (for example, the Market Minder menu) contains
commands for modifying and working with that study.  As you change the focus from one window to another on your
RealTick page, the study-specific menu will change.  Every study-specific menu contains the command Setup, which
opens the Setup dialog box.

For each study you must enter the symbol for the instrument you want the study to track.  Some RealTick studies track
data for many symbols at once; these studies require a list of symbols.  To make finding and using symbols easy, RealTick
provides pre-configured symbol lists and symbol search capabilities.

The RealTick toolbar contains a toolbar button for each study you are permissioned to use.  Click on a toolbar button
to create a RealTick study with a single click.  Favorites provide even shorter shortcuts.  Once you have created a
window you can save all its parameters by saving it as a favorite.  A list of favorites saved for each study is displayed in
the Favorites menu.  When you select a favorite from this list, the window will appear exactly as you configured it,
skipping the setup dialog.  You can also set a default favorite for each study type.  Once you have set a default
favorite, you can create that window by clicking on the appropriate toolbar button.  Default favorites appear in bold in the
Favorites menu.

Linking is a way to connect a quote screen to other RealTick windows on the same page so that when you change the
symbol in the quote screen, the other windows change their symbol as well.  You can change symbols quickly and easily
by dragging a symbol from one RealTick window and dropping it in the symbol box of another window.

This manual will acquaint you with the order entry-enabled RealTick studies and give you practice using many RealTick
features.  It will also provide you with the information on your trading route(s) and order entry options.  When you have
finished reading the manual you should be able to use RealTick with confidence and ease.  However, RealTick has far
more features than are described here.  For further information, please refer to the Introduction and Tutorial and RealTick
Features chapters of the help.  These help chapters are available on our website at http://www.taltrade.com/ (follow the
link for Support in the Products section) or via your Help menu within RealTick.
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Running RealTick for the first time

� To Run RealTick for the first time:
1. Run Windows 2000, Windows NT 4.0, Windows 98 or

Windows 95.
2. Click on the Start button in the lower left-hand corner of

your screen.
3. Select Programs from the Start menu and select TAL

Trading Tools from the popup menu. Then select
RealTick.

4. Enter your RealTick user name, domain and introductory
password in the RealTick login dialog.  For password
information, contact your system administrator.

5. If this is the very first time that you have run RealTick,
the Set Defaults dialog box will appear.  Click on OK to
accept all of the defaults.  If you want more information on these settings, consult the RealTick Features chapter of
the help.

6. Select Change Password from the Page menu and
enter a new password. Your password can include numbers as
well as lower-case and upper-case letters (RealTick passwords
are case sensitive). Choose  a password you can easily
remember. You will need to type your new password, type it again
to confirm the spelling, and enter your introductory password to
authorize the change. Click on OK.
7. Close RealTick, then run it again by selecting
Programs from the Start menu, then TAL Trading Tools from
the popup menu, then RealTick. Enter your user name, domain
and new password.

RealTick will open on your computer screen.  Most users will see an empty window with the name “Untitled” displayed in
the title bar.  The menu bar will have only four items available for selection:  Page, Design, Window (grayed out) and Help.
This empty window is a blank RealTick page.  Some users may see a pre-defined first page with studies already created on
it.  To follow this tutorial, users with pre-defined first pages need to select New from the Page menu to open a blank page.
You can create multiple pages, each with multiple windows.   However, you must create your first study before you can
name and save a blank page.

In addition to the title “Untitled” in the
RealTick title bar, your new page should
contain a menu bar, toolbar, control box
and system buttons.  The menu bar
displays all of the global RealTick menus.  The
toolbar contains shortcut buttons for the
commands in the Design menu, so that you
can create studies quickly and easily with
your mouse.  The control box contains the
RealTick system menu, which allows you to
set defaults, size, move, and close the
RealTick window.  The system buttons
enable you to maximize, minimize, and restore
the RealTick page with one click of your
mouse button.  First, you should maximize the
RealTick window (expand it to cover your
entire monitor) so that you have the largest available workspace.
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� To maximize the RealTick window:
• Click on the middle button in the upper right-hand corner of the RealTick window.  The button looks like a fully

opened window.

• Or select Maximize from the RealTick control menu, which is reached by clicking on the little RealTick icon in the
upper left-hand corner of the RealTick window.

Next, you will learn to create the first of the core trading windows, the Market Minder.

Create a Market Minder Window
The Market Minder window is a fully configurable quote screen that can show virtually any information on the instrument
of your choice.  Most commonly, for each symbol the Market Minder window lists the symbol, its last traded price, its last
direction of change represented by an up or down arrow, and the amount by which the current price differs from the
previous price.  The Market Minder can be used to trade by adding
an abbreviated order entry screen to the bottom.  A Market Minder
is a basic component of a trader’s RealTick page.  For this example,
we will create a Market Minder that tracks the NASDAQ 100 list.

� To create a Market Minder window:
1. Click on the Market Minder toolbar button, or select

Market Minder from the Design menu.  The Minder
Setup dialog box will appear.

2. Click on the Load Symbol File button.
3. Select Nasdaq-100.slf from the list of symbol files and

click on OK.
4. Accept the remaining settings for now and click on OK to

open your Market Minder window.
For comprehensive information on the Market Minder window,
please refer to the Market Minder help file on our website or in your
RealTick Help menu.

The Market Minder Display
The Market Minder display involves several rows and columns,
with each row representing a symbol and each column
representing a type of data.  You can change the data displayed
in the Market Minder window by changing the symbols
displayed or by changing the column layout, the collection of
columns (and therefore types of data) shown in the window.  We
encourage you to try out all of the layouts that are included with
your installation and to choose the column layout that best suits
your needs.  Once you have chosen a column layout, you can
customize your Market Minder window by sizing the columns,
setting the number of column groups, and sorting the data in the
display.



11

� To select a column layout:
1. Right-click inside the Market Minder window.
2. Select Load Column Layout from the popup menu.
3. Select a layout from the list of available layouts.
4. Click on Open.  The new layout will load into your
Market Minder window.
Sizing the columns is easy with your mouse; simply position the
mouse over a column divider until the pointer becomes a double
arrow, then drag the divider to the desired position.   By setting
the number of column groups, you can repeat your columns
across the screen.  Say, for example, that you have only four
columns in your Market Minder window and that you would like

your Market Minder data to stretch across your RealTick page.  Try setting the number of column groups to 3, and this
will give you 3 sets of four columns in your Market Minder window.  You can then re-size your Market Minder window to
stretch across the top (or the bottom) of your RealTick page.

� To set the number of column groups:
1. From the Market Minder menu, select Column Layout.  The

Column Layout Configuration dialog box will appear.
2. In the Layout Options area, change the Column Groups to

3.

• Use the up or down arrow buttons to set the number of column
groups.

• Or double-click on the number in the Column Groups box and
enter a new number.
3. In the Arrange area, select Vertically.
4. Click on OK.
5. Resize your Market Minder window so that all columns are

showing.  (The bottom scrollbar will disappear when all
columns are showing.)

Sorting Data in a Market Minder 
You can sort the information in your Market Minder window by any one of the columns, in ascending or descending
order.  For example, if you have a Last (price) column, you can choose to have the highest (or the lowest) price at the top
of your Market Minder display.  If you have a Change column, you can choose to have the largest positive (or the largest
negative) change at the top of your Market Minder display.  You can do a multiple-level custom sort.  For example, say
that for all identical trade prices, you want to know which one has the highest net change.  You can also tell RealTick to
put zero values at the bottom of the column that you sort, regardless of whether you have sorted the column in ascending
or descending order.  The order of the columns will not change when you sort the data.  If you would like to return to the
plain, alphabetical display of your Market Minder data, RealTick allows you to undo any sorting you may have done.
Finally, data in your Market Minder window can be centered, aligned left, or aligned right.

� To perform a simple sort on one Market Minder column:
1. Right-click on the column heading of the column by which you wish to sort your data.  For this example right-

click on the Last column heading.  You will see a popup menu with the following commands:  Sort Ascending,
Sort Descending, Custom Sort, Align Left, Center and Align Right.

2. For this example, select Sort Descending.  The Market Minder window will sort the rows so that the highest
trade price is at the top.
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� To perform a multiple-level sort:
1. Right-click in the Last column heading.
2. Select Custom Sort from the popup menu.  The

Custom Sort dialog box will appear.  You will see two
list boxes: Available and Selected.  The Available
list box contains all the columns that can be sorted;
the Selected list box contains all the columns that will
be sorted.

3. Last Price should already be entered in the Selected list box.  The Descending radio button should also
be selected.

4. Now select the Net Chg. item in the Available list box and click on the right-facing arrow button (>).
5. Select the Descending radio button.
6. Click on OK.  Now for all last prices that are the same, the one with the highest net change will be at the top.

� To undo any sorting in the Market Minder window:
1. Right-click on the column header again, notice that a new command, No Sorting, is available.  Selecting this

command from the pull-down menu of any column allows you to undo any sorting that took place in any
column of the Market Minder window.

2. For this example, don’t select the command, just notice it for future reference.
3. Left-click outside the menu to exit from it without selecting any commands.

� To align data in the Market Minder columns:
1. Right-click on the Last column header.
2. Select Align Left from the popup menu.

Once you have sorted your Market Minder data, you can add blank rows or text to your display.

� To add blank rows or text to a Market Minder window:
1. Select Setup from the Market Minder menu.
2. In the Setup dialog, type a space or a semicolon in the textbox under Selected Symbols. For a blank row, click

Add right away. For a group heading or notation, type your text after the space or semicolon.
Remember that the amount of text displayed in the Market Minder depends on the width of the Symbol column. Please
note that you cannot sort Market Minder columns after blank rows or text have been added.

Save Market Minder
Once you are happy with your Market Minder window, you should save it.  To save a window on a RealTick page, you
must save the entire page.  (You can also save a window as a favorite, which saves all the settings you have chosen so
you can re-create that window on any page.  More information on favorites is provided below.)  When you save a new
page, the Save This Page As dialog box opens.  You can name the page using upper or lower case characters or numbers.
Once the page is saved, the page name will appear in the title bar of the RealTick window.

Each time you add a new study to a RealTick page or modify an existing study, you should save the page, although you
only need to name it once.

� To name and save a page:
1. Select Save from the Page menu, or press Shift-F3.
2. In the Save This Page As dialog box, enter the name of

your page. For this example, enter Market as the name
for the new page.

3. Click on OK.
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Change Symbols
You can change the symbols displayed in your Market Minder window easily.  You originally loaded the NASDAQ
symbol list into this Market Minder window, but you may now want to change one or more symbols from that list.  To
delete a symbol, you must open the Minder Setup dialog box (by selecting Setup from the Market Minder window) and
delete from the Selected Symbols list.

� To change a symbol in the Market Minder window:
1. Double-click on a symbol.  The symbol will appear highlighted inside a box.
2. Enter a new symbol.
3. Press Enter.

� To delete a symbol from the Market Minder window:
1. Open the Minder Setup dialog box by selecting Setup from the Market Minder window.
2. Delete the desired symbols from the Selected Symbols list at top left.
3. Click on OK to accept the new list of symbols and return to the Market Minder window.

Save Changes as a Symbol File
If you have modified the symbols in the Market Minder window,
you can save your changes as a new symbol file.  This file will be
saved into your /Parm directory, where it can be accessed from
the Market Minder Setup dialog just like any other symbol file
(for example, the Nasdaq.slf that you used earlier).  Once you
have saved your symbol list as a symbol file, you can load it into
a Market Minder window or any other RealTick study.

� To save the symbols in your Market Minder window as a
symbol file:
1. Select Save Symbols from the Market Minder

menu.  The Save Symbols dialog box will appear.
2. Enter a name for your symbol file.
3. Click on the Save button.  You can now load these symbols into the Market Minder window at any time.

Save Market Minder Window as a Favorite
Once you have a Market Minder window set up exactly as you like it, you can save it as a favorite and add it easily to any
page.  For example, you might want a standard NASDAQ Market Minder window on several pages.  A Market Minder
favorite will retain the column layout, number of column groups, symbols/symbol file, and sorting of the original window.
Using Favorites, you can skip the setup process for this study.

� To save the Market Minder window as a Favorite:
1. Select Add to Favorites from the Favorites menu.
2. For this example, enter Market Minder Tutorial in the Save Favorite dialog box as the name of this Favorite.
3. Select the Save Position check box and leave the other check boxes blank.
4. Click on OK.  Now when you right click on the Market Minder toolbar button, a drop-down menu will appear

with Market Minder Tutorial as a choice.  Click on it in a new
page to add this study to that page.
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Create a MarketMaker window
The MarketMaker window is a composite window designed to show you full Level II information on a single symbol.  The
top panel is a MultiQuote window; below that is a range bar; and below that is the MarketMaker data.  An abbreviated
Order Entry Screen can be added to the bottom of the window, and a single-instrument ticker can be displayed at right.
For more detailed information about MarketMaker windows, please refer to the MarketMaker chapter of the RealTick help.

� To create a MarketMaker window:
1. Click on the MarketMaker toolbar button or select

MarketMaker from the Design menu.  The Market
Maker/ Regional Setup dialog box will appear.

2. Select the Auto-Detect radio button.
3. Check the Uppercase Only check box.
4. Enter a symbol into the Symbol text box.  For this

example, enter MSFT.
5. Accept the remaining settings in the dialog box and click

on OK.  The MarketMaker window will appear on your
screen.

If you do not see any data, you may not be connected to a server
that distributes Market Maker data, or the market may be closed.
If you have a server problem, ask your System Administrator for
help.

The MarketMaker Display
When you first create your MarketMaker window, it
will have three panels arranged from top to bottom.
The top panel is a MultiQuote window, which displays
fundamental information on a single instrument.  You
can change the layout, font and background color with
the commands in the MultiQuote popup menu.  Right-
click inside the MultiQuote panel to see the menu.

The Range Bar in the middle of the MarketMaker
window shows the relative number of market makers at
each level of the market.  The Range Bar uses the same
colors used for the Level II or Regional data below.

The bottom panel of the MarketMaker window displays
either NASDAQ Level II data or Regional data for

multiply listed stocks; it can also show the book information for an ECN.  The MarketMaker screen sorts and color codes
the bids and asks according to their relationship to the inside market.  The default colors range from yellow, which
represents the highest bid and lowest ask, to dark blue, which represents the lowest bid and highest ask.  However, you
can change the colors to suit your own preferences.  For instructions, read the MarketMaker chapter of your online help.

You can add a Level II Ticker to your MarketMaker window.  This Ticker will display the Last Price and the Volume for the
instrument in your main MarketMaker window.  By default, prices are displayed in descending order in the Ticker window:
when the Ticker window fills up, the newest price is at the bottom.  To add a Ticker, select Show Ticker from the
MarketMaker menu.  To configure the Ticker so that new prices appear at the top of the display, select Setup from the
Market Makers menu and select New Line on Top from the Ticker Properties section of the dialog box.  You can access the
Market Makers menu either by right-clicking inside your MarketMaker display or by selecting the MarketMaker menu
command from the RealTick menu bar.

You can also add a Market Montage to your MarketMaker display. The Market Montage table shows the aggregate
volume of shares being bid and the aggregate volume of those being offered at each of a stock’s price levels. To add the
Market Montage, select Show Market Montage from the MarketMaker menu.
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Monitor Market Participants
You can highlight one or more market participants in your MarketMaker screen.  RealTick will put a black inverse video
bar over each row containing a monitored market participant’s name.  This makes it very easy to track a particular market
maker’s or ECN’s market.

� To highlight a market participant:
• Right-click on a market maker’s or ECN’s ID in the Name column and select Monitor from the popup menu, or

• Open the Setup dialog box by selecting Setup from the MarketMaker menu and enter the market maker’s or ECN’s
ID(s) in the Monitor box. Multiple IDs should be separated by a comma.

� To deactivate monitoring:
• Right-click on a monitored market maker’s or ECN’s ID in the Name column. A checkmark will appear next to

Monitor in the popup menu. Click on Monitor to deactivate monitoring, or

• Open the Setup dialog box and delete the ID from the Monitor box.

Save the Page Again
Once you have your MarketMaker window set up as you like it, save the page again to save the new window.

� To save the RealTick page:
• Select Save from the Page menu, or

• Hold Shift and press F3.

Create a Time & Sales Chart
The Chart window can display tick and bar data in just about any way imaginable; it can display technical studies on the
chart data; it can graph multiple symbols in the same chart window.  Time & Sales Charts, Bids Only Charts and Asks
Only Charts are also available.

� To create a Time & Sales chart:
1. From the Design menu, select Chart, or click on the Chart

toolbar button.  The Setup Chart dialog box will appear.
2. Click once inside the Symbols box and enter MSFT.
3. Click on the Add button.
4. Select Time & Sales from the Period drop-down list box.
5. Make sure that the Days Back setting is set to one (1).
6. Double-click inside the Chart Title text box and enter “Time &

Sales Chart.”
7. Click on OK.  The chart window will appear on your RealTick

page.
8. Size the Chart window and move it to a suitable location.

We encourage you to play with your chart window.  Commands that modify the appearance and function of your chart
window are found in the Chart menu, which is available in the RealTick menu bar when a Chart is the active window on
the page.  For more information on the Chart menu and other Chart window attributes, please refer to the chapter of the
RealTick help devoted to The Chart.
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Arrange Your Studies on the Page
Now that you have three windows on your RealTick page, you should decide how you want them arranged.  The easiest
way to arrange child windows is using the Window menu.  The commands Tile, Tile Horizontally, and Cascade
automatically arrange the child windows in order.  Try each one to see which you prefer.  If you don’t like any of the
automatic arrangements, you can size and move your child windows yourself.  To size a child window, point to the edge of
the child window until your pointer becomes a double-headed arrow.  Then drag (click, hold the mouse button down, and
move the mouse) that edge to its new position.  To move a window, click on the title bar and drag the entire window to its
new position.  When you find a setup you like, save the page to save the new arrangement.

Linking Windows
Linking allows you to change the symbol in all the single symbol windows on a page together.  On the page you have
created in this tutorial, you have two options for linking.  You can link your MarketMaker window (using the MultiQuote
component) to the Time & Sales Chart, and then change the symbols in those two windows by dragging and dropping
symbols from your Market Minder into the MarketMaker window.  Or you can link the other two windows directly to the
Market Minder window and change the symbol in the MarketMaker window and the Time & Sales Chart using the
keyboard.   We suggest that you try both alternatives and decide which works best for you.

� To link your windows from the MarketMaker window:
1. Right-click inside the MultiQuote panel at the top of

your MarketMaker window.  Select Links from the
popup menu.  The Select Window to Link dialog box will
open, and you will see a box that contains a list of the
windows available for linking.

2. Click on your Time & Sales Chart in the list of windows.
(To un-link a linked window, you must hold down the
CTRL key and click.)

3. Click on OK.
To change the symbol in the linked windows, click and hold on a symbol from your Market Minder.  The pointer will
become a circle with a diagonal slash.  Drag the mouse pointer to the MarketMaker window, where the pointer will become
a circle with two arrows, and let go.  The symbol will change in both linked windows.

� To link your windows from the Market Minder window:
1. Right-click inside the Market Minder, but not on a symbol.  Select Links from the popup menu.  The Select

Window to Link dialog box will open, and you will see a box that contains a list of the windows available for
linking.

2. Hold down the CTRL key and click on your MarketMaker window and Time & Sales Chart in the list of
windows.  (To un-link a linked window, you must hold down the CTRL key and click.)

3. Click on OK.
Since the Market Minder displays many symbols and the MarketMaker window can only display one symbol, changing
symbols in linked windows from a Market Minder is slightly more complicated.  In the Market Minder, select the symbol
you want the linked windows to display.  While the desired symbol is selected, hold down the ALT key and hit the Enter
key.

Moving On
So far, you have learned to set up and work with several RealTick windows, but you have not yet seen any of RealTick’s
order entry features.  The next section, Trading Features, will teach you to get your market monitoring page ready to trade.
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Trading Features
Before you trade, you must set your order entry defaults, add an order entry form to one of your windows, and create
windows to track your orders, positions, and account(s).  There are nine variables involved in submitting any order:
Symbol, Price, Price Type, Volume, Volume Type, Route, Expiration, Order Type, and Account.  Of these nine, you should
set default values for five:  Price Type, Volume, Volume Type, Route, and Expiration.  The Symbol and Price are generally
entered automatically from the data in your trading window.  The Account can only be set for a particular trading window,
not for an individual order.  The Order Type is set when you choose an order button – Buy, Sell, or Cancel.

Three RealTick windows have order entry capabilities.  The MarketMaker window can include an order entry form under
the Level II data.  The TurboOptions window offers an order entry form for options traders along with option quote chain
data.  The Market Minder window, a quote screen that monitors customizable lists of symbols, has an appended order
entry form that can trade any of the symbols displayed with the click of a mouse.  In addition to your order-placing
window, you should have an Order Minder window to monitor your orders as they are submitted and filled, a Position
Minder to track your positions in the market, and an Account MultiQuote to follow your account balance.  Some
customers can also add the ability to trade baskets of instruments using a Basket Minder.  Finally, the Order Entry Screen
offers a range of order information.

Security concerns
RealTick is designed to allow a smooth transition between study windows.  Therefore, there is no separate password for
any of the trade-enabled windows within RealTick.  If you leave RealTick running on your workstation while you are away
from your desk, someone else can trade from your account.

Order Entry Defaults
Before you add order entry capability to your trading windows, you should set the five default order entry parameters.
The default settings will then be pre-set in your trading windows, speeding the entry of the majority of your orders.  You
can change any of these five parameters before entering an order if you wish.  In the Options tab of the Order Entry
Properties dialog box you can also set the increments by which the price and volume change when you modify them
using the “spin buttons” or up and down arrows next to the price and volume boxes.  The Spin Button Increments
settings determine how much the price and volume change each time
you click on a spin button.

The Route may determine the available values for some of the other
variables.  For example, Island does not accept All or Nothing orders.
All the settings available for each variable are described below.  In
addition, where available values differ among trading routes, tables
show which settings are available for each trading route.

� To set the order entry defaults:
1. Right-click in either a Market Minder or MarketMaker window.
2. Select Order Entry Properties from the pop-up menu.
3. Click on the Routing tab.
4. Select a default route for each type of instrument listed.
5. Click on the Options tab.
6. Select a default Expiration, Price Type, Volume Type, and Volume.
7. Set the Spin Button Increments.
8. Click on OK to accept the new defaults.
9. Select Save Defaults from the Window menu to save the settings globally.
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Price Type:  There are five available Price Types in RealTick:  Market (buy or sell at the best available price), Limit (buy
or sell at the price specified or better), BBO (Best Bid or Offer), MID (the mid point between the bid and the ask), Stop

(send a market order when the price reaches this level), Stop-Limit (send a limit order when the price reaches this level),
PostNoPreference (post on Archipelago but do not preference out to a NASDAQ market maker), and Discretionary (post
at one price level with a hidden price component). For more information on Stop, Stop-Limit, PostNoPreference, and
Discretionary orders, please see the sections of this
manual devoted to those order types.

Volume:  The default volume should be set to the
number of shares you usually buy or sell.  When you
actually enter an order, you can change the volume for
that order by typing a new volume in the volume box
and hitting the Enter key, or by using the spin buttons
(up/down arrows) to adjust the volume.

Volume Type:  Two Volume Types are available.  The
Volume Type you choose determines how your order
will be filled at the exchange.  AON (All or Nothing)
orders will not be filled unless they can be filled
entirely.  Partial orders, if they cannot be filled entirely,
will be filled in part.  The exchange will fill as much of
each order as possible.

Route:  Six live routes are available in RealTick:  four
for NASDAQ securities and two for other securities.  In addition to these standard trading routes, your system adminis-
trator may set up one or more manual routes, which will send orders to a clerk who will relay them to the exchange.  You
can set default routes for each type of instrument (options, futures, futures options).

ARCA:  The Archipelago ECN.  Only NASDAQ securities.  Check Expiration, Price Type, and Volume Type for
available settings.

ISLAND:  The Island ECN.  Only NASDAQ securities.  Check Expiration, Price Type, and Volume Type for
available settings.

SOES:  The Small Order Execution System.  Only NASDAQ securities.  Check Expiration, Price Type, and
Volume Type for available settings.

VOLUME TYPE:

ARCA

Island

SOES

SelectNet

ISI

CSS

AON

No

No

No

Yes

Yes

Yes

PART

Yes

Yes

Yes

Yes

Yes

Yes

PRICE TYPE:

ARCA

Island

SOES

SelectNet

ISI

CSS

Market

Yes

No

Yes

No

Yes

Yes

Limit

Yes

Yes

Only if marketable
(1st or 2nd tier)

Yes

Yes

Yes

BBO

Yes

Yes

Yes

Yes

Yes

Yes

MID

Yes

Yes

Yes

Yes

Yes

Yes

Stop

Yes

No

No

No

Yes

Yes
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SelectNet:  The SelectNet trading network.  Ask your broker-dealer if this is available to you.  Only NASDAQ
securities.  Check Expiration, Price Type, and Volume Type for available settings.

ISI:  Orders go to ABN-AMRO.  Only listed securities.  In addition, Southwest will only route your orders to the
main exchange for the instrument, not to any of the regional exchanges.  No NASDAQ trading. Check Expiration,
Price Type, and Volume Type for available settings.

CSS:  Orders go to Southwest Securities.  Only available to people with trading accounts at Southwest Securi-
ties.  In addition, Southwest will only route your orders to the main exchange for the instrument, not to any of
the regional exchanges.  Check Expiration, Price Type, and Volume Type for available settings.

TALX:  Used for demonstration purposes only.  TALX is Townsend Analytics’ practice exchange.  No actual
orders will be placed.  Order, position, and account monitoring features will work with these mock orders.

Manual routes:  You may have other routes available, manual routes which your system administrator will
name.  Manual routes send electronic orders to a clerk, who relays them to the desired exchange.  For restrictions
on particular manual routes, please contact your system administrator.

Expiration:  Three Expiration options are available in RealTick: Day, Day+, GTC, and IOC. The Expiration determines
how long your order will remain open on the exchange if it cannot be filled immediately. DAY orders remain at the ex-
change until the end of the current trading session. Day + orders span all trading sessions and remain in effect until the
selected exchange or ECN closes. Good Til Cancel orders (GTC) remain at the exchange until you cancel them or until they
are filled.  NASDAQ does not allow orders to remain at the exchange beyond the current trading day, so a GTC order has
the same duration as a DAY order at NASDAQ. Immediate or Cancel orders (IOC) will be canceled unless they can be
filled immediately.

Spin Button Increments:  The amounts by which your prices and volumes change when you use the up or down
arrow buttons to modify them.  Select a Price increment.  The price in your order entry forms will change by this amount
when you use the spin buttons (up/down arrows) to modify it.  Select a Volume increment.  The volume in your order
entry forms will change by this amount when you use the spin buttons (up/down arrows) to modify it.

EXPIRATION

ARCA

Island

SOES

SelectNet

ISI

CSS

IOC

Yes – fills the order on the
ARCA internal book if
possible; otherwise
cancels

Yes – fills the order on the
Island internal book if
possible; otherwise
cancels

No

Yes – must be filled within
3 minutes

Yes

Yes

GTC

No

No

No

No

Yes

Yes

DAY

Yes

Yes

About 1.5 minutes

Yes

Yes

Yes
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Save Defaults and Choose a Trading Window
Once you have set your order entry defaults, you can choose the window you will use to trade and set it up for trading.  If
you are trading options, then the TurboOptions window is the obvious choice for a trading window.  If you are trading
other securities, you can enter orders from either the MarketMaker or the Market Minder or the MarketMaker window.
We suggest using the MarketMaker window, but you may try trading from both windows to see which one you prefer.

Set up a MarketMaker Window to Trade
Preparing to trade from a MarketMaker window involves two optional steps (displaying an ECN book and adding a ticker)
and two required steps (adding an order entry form and selecting an account).

Display an ECN Book
If you decide to trade from a MarketMaker window and you are trading via an ECN, you should set your MarketMaker
window to show the appropriate ECN book.

� To configure the MarketMaker window to
display an ECN book:
1. Select Quote Sources from the

MarketMaker menu.  The Quote Sources to
Display dialog box will appear.

2. Click on the Show Selected Sources
Only radio button.

3. Select the appropriate ECN from the list box
below.

4. Click on OK.  The ECN book will appear in
your MarketMaker window.

Add a Ticker
If you decide to trade from a MarketMaker window, you
may want to add a Ticker that shows only quotes for the stock shown in the MarketMaker screen.  A MarketMaker Ticker
is displayed on the right side of the window as an integral part of it, much like the MultiQuote at the top.

� To add a Ticker to your MarketMaker window:
1. Make sure that the MarketMaker window is the active window on the page.
2. Select Show Ticker from the MarketMaker menu.

Add an Order Entry Form
Next, you will need to add an order entry form to the bottom of your MarketMaker window.  Be sure to check that your
order entry default settings are correct when the order entry form appears.

� To add an order entry form to a MarketMaker window:
1. Click inside the MarketMaker window to activate it.
2. Select Show Order Entry Screen from the MarketMaker menu.  An

order entry form will appear at the bottom of the Market Minder window.
3. Size the window so that all of the information in the order entry form is

showing.  The Volume, Volume Type, Price Type, and Expiration should
be set to the default settings you created.  The Route should be set to
“default.”  You should have three order entry buttons available:  Buy,
Sell, and Cancel All.
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Select an Account
Finally, you will need to select an account from which to trade.  Even if you only have one account available, you need to
select it to associate it with this individual order entry enabled window.  If you trade from more than one account, you can
assign each account to a different window, even if the windows are on the same page.  Each window will display the
account name in its title bar so you can see at a glance which account you are trading from.  You can change the account
for a particular window by choosing Select Account from the MarketMaker menu.  The Select Account dialog box will
appear again, and you can choose a new account to associate with the window.

� To select an account for a MarketMaker window:
1. Choose Select Account from the MarketMaker menu.  The Select Account dialog box will appear.
2. Select an account from the list and click on OK.  Even if only one account appears in this dialog box, and that

account is highlighted, you must still click on it and on OK to select an account.
3.  The name of the account will appear in the title bar of the window.
Your MarketMaker window is now ready to trade.  Before you begin trading, however, you need to add position, order,
and account tracking windows to your page, so that you can monitor your trading progress carefully.

Set up a Market Minder to Trade
In general we recommend that you trade from the MarketMaker window. However, the Market Minder window is also
equipped for order entry. Preparing to trade from a Market Minder window involves one optional step (adding a ticker)
and two required steps (adding an order entry form and selecting an account).

Add a Ticker
If you decide to trade from a Market Minder window, you may want to add a Ticker that shows only quotes for the stocks
included in the Market Minder.

� To add a Market Minder Ticker:
1. Make sure that the Market Minder window is the active window on the page.
2. Select Show Ticker from the Market Minder menu.

Add an Order Entry Form
Next, you will need to add an order entry form to the bottom of your Market Minder.  Be sure to check that your order
entry default settings are correct when the order entry form appears.

� To add an order entry form to a Market Minder window:
1. Click inside the Market Minder window to activate it.
2. Select Show Order Entry Screen from the Market Minder menu.  An order entry form will appear at the

bottom of the Market Minder window.
3. Size the Market Minder window so that all of the information in the order entry form is showing.  The Volume,

Volume Type, Price Type, and Expiration should be set to the default settings you created.  The Route should be set
to “default.”  You should have three order entry buttons available:  Buy, Sell, and Cancel All.

Select an Account
Finally, you will need to select an account from which to trade.  Even if you only have one account available, you need to
select it to associate it with this individual order entry enabled window.  If you trade from more than one account, you can
assign each account to a different window, even if the windows are on the same page.  Each window will display the
account name in its title bar so you can see at a glance which account you are trading from.  You can change the account
for the Market Minder window by choosing Select Account from the Market Minder menu.  The Select Account dialog
box will appear again, and you can choose a new account to associate with the window.



22

� To select an account for a Market Minder window:
1. Choose Select Account from the Market Minder menu.  The Select Account dialog box will appear.
2. Select an account from the list and click on OK.  Even if only

one account appears in this dialog box, and that account is
highlighted, you must still click on it and on OK to select an
account.

3. The name of the account will appear in the title bar of the
window.

Your Market Minder window is now ready to trade.  Before you
begin trading, however, you need to add position, order, and
account tracking windows to your page, so that you can monitor
your trading progress carefully.

Add Order Tracking
Before you enter any orders, you should configure a Market Minder
window to track the progress of your orders.  An Order Minder will
track your orders to all exchanges in real time throughout the day,
but only for a single account.  If you trade from multiple accounts,
you should create multiple Order Minder windows to track your
order history.

If you enter an order and it does not appear in your Order Minder window DO NOT TRADE!  Get help from your System
Administrator or call Townsend Analytics, Ltd. for technical support.

� To track today’s orders:
1. Select Market Minder from the Design menu.
2. In the Minder Setup dialog, select the Orders radio button in the Minder Type section.
3. Click on the Select Account button.  The Select Account dialog box will appear.
4. Double-click on the account that you use for trading, or select the account and click on the OK button.  Even if

only one account appears in this dialog box, and that account is highlighted, you must still click on it and on
OK to select an account.

5. If you want your Order Minder to display a history of all orders placed from that account, check the Show
Completed Orders check box, located in the Miscellaneous section.  If you do not check this option, the
Order Minder will only display pending orders.

6. Click on OK.  The Order Minder window will appear on your page
and catalogue your order history throughout the trading day.

Order Confirmation
If you wish, you can set RealTick to confirm each order you place.  This adds a
keystroke to your order entry, but allows you to check the parameters of each
order before sending it to the exchange.  Please be aware that enabling
Confirm All Trades will trigger a confirmation dialog box for cancellations as well.  For more detailed information, please
refer to the section on Canceling Orders.
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� To have RealTick confirm each order:
1. Right-click inside the upper panel of the Order Entry Screen.
2. Select Order Entry Properties from the popup menu.  The Order Entry Properties dialog box will appear.
3. Be sure that the Warnings/Confirmations tab is visible.
4. Check the Confirm All Trades check box.
5. Click on OK.  RealTick will confirm each order with you

before sending it to the exchange.

Add Position Monitoring
You should also configure another Market Minder window to keep
track of your positions.  A Position Minder will track your positions
in all instruments in real time throughout the day, but only for a
single account.  If you trade from multiple accounts, you must create
multiple Position Minder windows.

If your positions do not appear in your Position Minder, DO NOT
TRADE!  Get help from your System Administrator or call Townsend
Analytics, Ltd. for technical support.

� To display your positions in a selected account:
1. Select Market Minder from the RealTick Design menu.
2. In the Minder Setup dialog box, select the Positions radio

button in the Minder Type section.
3. Click on the Select Account button.  The Select Account dialog box will appear.
4. Double-click on the Account that you use for trading, or select the account and click on the OK button.  Even

if only one account appears in this dialog box, and that account is highlighted, you must still click on it and on
OK to select an account.

5. If you want your Position Minder to show your closed positions as well as your open positions, check the
Show Closed Positions check box located in the
Miscellaneous section.

6. Click on OK.  The Position Minder window will open and
display your positions in the selected account, and it will
update the information as you trade.

Select a Layout Suitable for Position Monitoring
Not all Market Minder column layouts are suitable for position
monitoring.  If you open a Position Minder window and you do not see
columns like Pos Long, Pos Short and Pos (Net Position), select a more
suitable column layout for your Market Minder window.

� To select a column layout for your Position Minder window:
1. Select Load Column Layout from the Market Minder

menu.
2. For a position minder layout, select pos.bvw from the list of

available layouts.
3. Click on Open.

Display Column Totals
A Position Minder window can total the numbers in your columns and display the totals at the bottom of each column.
You can use this feature to keep track of your portfolio’s net worth in real time as you trade.
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� To calculate and display column totals:
1. Select Column Layout from the Market Minder menu.  The Column Layout dialog box will appear.  You will

see a box containing a list of columns that are available for display in your Market Minder window.  The
column names with check marks beside them are the columns that are actually displayed.

2. Select a column in the list box.  For example, select PL Total.
3. Put a check in the Compute Total check box.
4. Repeat steps 2 and 3 for any other columns for which you would like to display totals.
5. Make sure the Column Footers checkbox is checked.
6. Click on OK.  The Market Minder window will compute and display the totals.

Add Account Monitoring
To track the balances in your trading account, you should
configure a MultiQuote window to display account
information such as balances, profits, margining, and
withholding.  Special MultiQuote layouts provide this
information.  The default account monitoring layout is called
Account detail.mqt; your system administrator can inform
you of other available layouts for account monitoring.  All
account monitoring layouts display the same information;
the categories are described below.

Your broker-dealer may impose margin controls, which
restrict your buying power based on equity levels.  RealTick
will enforce the limits set for each account.  When your
buying power is insufficient to allow you to make a specific
trade, RealTick will send you a “Not sending trade to server,
margin requirement not met” message.  Use an Account MultiQuote to keep track of your margin requirements and buying
power throughout the trading day.

� To create an Account MultiQuote window:
1. Select MultiQuote from the Design menu, or click on the MultiQuote toolbar button.  A standard Windows

Open dialog box will appear.
2. Select Account detail.mqt from the list of available layouts.
3. Click on Open.  The Select Account dialog box will appear.
4. Select an account from the list of available accounts and click on OK.  Even if only one account appears in this

dialog box, and that account is highlighted, you must still click on it and on OK to select an account.  The
MultiQuote window will appear and display your position information.

The Account MultiQuote window displays your account identification information, overnight account information,
updating positions for any instrument you held overnight, and current buying power information.

Overnight account information

The three values relating to your overnight positions (Overnight Market Value, Overnight Equity, and Overnight Margin
Requirement), remain constant throughout the trading day.

Current account information
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The lower left section of the account MultiQuote shows your current buying power in real time. Your Opening Excess
Equity is the amount of money in your account at the beginning of the day.  This number is constant. Scalped loss
updates only when a position is liquidated. Intraday margin is the amount of money currently in use to hold your open
positions.  When you increase your position, this amount increases by a percentage times the price times the volume.
The percentage is a function of the price and the security type.  For stocks whose price is greater than $4, it is 50%; for
other securities it is 100%.  For example, if you buy 100 ABCD at $10 per share, your withholding increases by .5*100*10,
or $500.  If you were to sell 50 of those shares, your withholding would decrease by $250, regardless of the price at which
you sold. Pending margin is the amount of money needed to hold your pending orders if they are all filled. Available
Equity should be equal to Opening Excess Equity plus credits minus Debits at any time during the day.

Overnight position information

The upper right section displays your current positions, but only for instruments in which you held an open position
overnight.

Set Pre-configured Order Actions (HotKeys)
To further automate the process of entering orders, RealTick provides short-cut Order Actions that can be accessed using
HotKeys.  To design an Order Action, configure the exchange, action (buy, sell, cancel, etc.), volume, price type (market,
limit, etc.), and duration.  Assign that combination a HotKey.  To use the Order Action, indicate the symbol you want to
trade by selecting a MarketMaker window or selecting an instrument in a Market Minder window.  Then type the HotKey
(hold the Control key and type the letter).  Or right click inside your MarketMaker screen to access the list of available
Order Actions, then choose one.  By default, RealTick does not confirm orders placed using HotKeys.

Your software may arrive with some Order Actions already configured and assigned HotKeys.  To see your available
Order Actions:  right-click on a Market Maker ID in the MarketMaker window, or right-click on a symbol in the Market
Minder window.  A popup menu will appear showing all available Order Actions and the HotKeys assigned to them.  If
you do not see a menu when you right-click, you do not have any preconfigured Order Actions with HotKeys.  The
following sections illustrate how to configure HotKeys.

Four of the Order Actions (Buy, Sell, Bid, and Ask) allow you to trade quickly using a predetermined price type, route,
duration, and volume.  Three additional Order Actions allow you to cancel orders and close positions quickly.  A Cancel
Orders (Symbol) hotkey will cancel all orders for the selected symbol in the active account.  A Cancel Orders (Account)
hotkey will cancel all orders for all symbols in the active account. A Close Position hotkey will automatically close out
your open position in the selected instrument in the active account.

Configuring HotKeys

� To configure a HotKey:
1. Click inside an order-entry enabled window to activate it.
2. Select Order Entry Properties from the window menu.  The Order Entry Properties dialog box will appear.

Select the Actions tab.  The list box displays all of your available Order Actions (if any) and their associated
HotKeys.
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3. Click on the Create button.  The Edit Order Action dialog box will open.
4. Select the Action you desire (Buy, Sell, Bid, Offer, Cancel Orders (Symbol), Cancel Orders (Account), or Close

Out Position).  If you want to configure a Short Sell or Short Offer HotKey, place a checkmark in the Short Sell/
Offer box (this box is only available when either Sell or Offer is selected in the Action section).  If you choose
Cancel Orders, skip to instruction # 7.

5. Configure the Order Options.

• Select the Price Type from the drop-down list box (this will not be available when Bid or Offer is selected as the
Action),

• Select the exchange from the Route drop-down list box,

• Select the order duration from the Good Until drop-down list box, and,

• If appropriate, set the Bid/Offer Options. If you select the Best radio button, RealTick will automatically send a limit
order at the current best bid or offer.  If you select the Up or Down radio buttons, the Adjustment box will
become activated.  Use the arrow buttons to select the interval from the top of file at which you want to trade.  For
example, if you always bid at 1/8th below the top of file, select the Down button and select 1/8 in the Adjustment
box.  RealTick will automatically send a limit order at the price that is the Best Bid - 1/8.  If you always offer at 1/8th

above the top of file, select the Up button and select 1/8 in the Adjustment box.  RealTick will automatically send a
limit order at the price that is the Best Offer + 1/8.
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6. Configure the Volume.  Use the up or down arrow buttons to select the volume, or double-click on the volume
and enter a new volume.  Select AON or PART from the drop-down list box to the right.  The Round Volume
box makes RealTick aware of partially filled orders.  If you check Round Volume and your order is only
partially filled, RealTick will automatically configure your next order for that instrument to round out the
position you were originally seeking.  Thus, if your first order to buy 1000 shares is only half filled, the next
time you use this HotKey for the same instrument RealTick will enter an order for the remaining 500 shares of
your original order.  It will continue to enter new orders at volumes determined in this way until the volume of
the original order has been completely filled.

7. In the HotKey section, select a HotKey letter.  Use the up or down arrow buttons to select the letter, or
double-click inside the box and enter an upper case letter.

8. The description is the text that appears in the list of available Order Actions and their associated HotKeys.  To
change it, clear the Auto check box and edit the text.

Save Your Trading Page
Your page is now set up to enter orders and monitor your trading progress.  Before you enter your first trade, save this
page again.

Entering Orders
Once your trading page is set up and your order entry defaults have been set, you are ready to enter orders.

� To enter an order:
1. Make sure that the window is trading from the desired account.  The account will be displayed in the title bar of the

order entry enabled window.  If necessary, change the account using the Select Account command in the Market
Minder, MarketMaker, or TurboOptions menu.

2. Enter a symbol and price for your order.  If you are trading from a TurboOptions window or a Market Minder, click
on a row in the display to enter that symbol and the last traded price.  If you are trading from a MarketMaker
window, the symbol for an order is the one being tracked in the main part of the window.  To enter a price in a
MarketMaker window, click on the row displaying the desired price.

3. If necessary, adjust the price using the up or down arrow buttons.  Or type a price directly into the price area in the
order entry form and hit the Enter key.

4. Check the default parameters (price type, volume, volume type, route, and expiration).  If necessary, you adjust
these settings and/or defaults.

5. If you are selling short, check the Short Sell check box.  RealTick will mark your order as a short sell when it sends
the order to the exchange.  Note that the Short Sell check box will remain selected until you click on it again to clear
it.  You should only select this box when it is appropriate.

6. Click on the appropriate order button to determine the order type and simultaneously send the order to the
exchange.  If you are selling, choose the Sell button.  If you are buying, choose the Buy button.

7. If there are any problems with your order, for example, if the order would lock or cross the market, or if your buying
power is insufficient, you will receive a popup warning from RealTick and the order will not be submitted to the
exchange.

8. When you have sent an order, immediately look in the Order Minder window.  If your order does not appear, STOP
TRADING!  Get help from your system administrator or call Townsend Analytics, Ltd. for technical support.

Using Order Actions (HotKeys)

� To use an Order Action shortcut (with or without a HotKey):
1. Click on a MarketMaker window or on a price in a Market Minder window to enter the desired symbol.
2. Press the HotKey sequence (hold down the Ctrl key and press the HotKey letter or number).
OR

1. From within a MarketMaker window displaying the symbol you wish to trade, right-click to access a list of all
available Order Actions.

2. Click on the Order Action you wish to use.
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Preferencing
You can preference a market maker on SelectNet.  When you preference a market maker, RealTick sends the order only to
the market maker that you designate.  The order is not sent to the broader marketplace.

� To preference an order:
1. Before you send the order, check the Preference check box.
2. Enter the Market Maker ID of the broker that you want to preference, or click on the Market Maker ID in the

MarketMaker screen.
3. Click on the appropriate order button to send the order.  The order will only be sent to the broker that you

specified.

PostNoPreference
Orders sent to Archipelago that are not filled at Archipelago within a certain amount of time are forwarded to SelectNet
with preferencing determined by Archipelago.  If you want your order to remain only on Archipelago, select
PostNoPreference as your order type.

Reserve and Discretionary Orders
Archipelago offers two order types with hidden components: Reserve orders and Discretionary orders.

Reserve orders hide your total size so that you don’t pay a higher price because you’re buying a large volume of shares.
A reserve order (formerly called a managed order) is a large order that appears in the market as a series of smaller orders.
Please be aware that your permissions must specify that you can enter reserve orders.

Discretionary orders allow you to enter a hidden price component, to improve the chances of getting a fill in a fast-moving
market. The discretionary price must be better than the posted price (higher bid or lower offer). The order will be posted at
your initial price and filled at that price if possible. If other orders are posted at a better price, they will be filled first. But if
the market starts to move, and an order comes in above your posted price but below or at your discretionary price, your
order will have the flexibility to move with the market. Please be aware that your permissions must specify that you can
enter discretionary orders.

� To send a reserve order:
1. Confirm that you are permissioned to send reserve orders.
2. Select Order Entry Properties from any order entry enabled window

(Market Makers, Market Minder, etc.) and open the Options tab.  Make
sure that Convert ARCA Managed Orders to Reserve Orders is
checked.
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3. If desired, turn to the Managed Orders tab of the Order Entry Properties dialog box to set your reserve order
defaults. You can set a default Reserve Amount (the total number of shares ordered in a reserve order), the
Execution Delay (the amount of time between sending one portion of a reserve order and sending the next), and
a range of price for your reserve orders (default values are 5% above and 5% below the current price).

4. Click on OK to close the Order Entry Properties dialog box.
5. Open a new order entry-enabled window to trade and check the box under Reserve. The Reserve Amount box

will now display the default Reserve Amount. Adjust if desired.
6. The Volume box in your order entry form will now be called Show.  Set the volume of each component order of

the reserve order there.
7. Click on the appropriate order button to send your reserve order to Archipelago.

� To send a discretionary order:
1. Confirm that you are permissioned to send discretionary orders.
2. In any order entry-enabled window, select Discretionary as your order type.
3. Click on the Buy button for a buy order, or the Sell

button for the sell order. The Submit Discretionary
Order dialog box will open.

4. In the Submit Discretionary Order dialog box,
confirm the order details (Buy or Sell, symbol,
volume, exchange, and posted price) and enter a
discretionary price. This is the highest price you
are willing to pay or the lowest price you are willing
to accept.

5. Click on Submit to send your discretionary order to
Archipelago.

Conditional Orders
Single-instrument and cross-instrument conditional orders let you pursue sophisticated trading strategies with ease. You
can enter a limit order away from the market without revealing your strategy. RealTick will hold the single-instrument
conditional order on the desktop until the market meets your specified condition. You can also take advantage of patterns
in the market using cross-instrument strategies such as these:
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• Peg an options order to the price of the underlier.

• Base a stock trade on the level of an index.

• Link an order for a stock to activity in a commodity.
Conditional orders may not be available for all trading customers.

� To set up a Conditional Order:
1. Check Conditional Order in any order-entry enabled

window.
2. Click on an order button (Buy or Sell) to open the Enter

Conditional Order dialog.
3. In the Trigger Condition section of the dialog, enter the symbol

for the instrument you want to track, along with the other
parameters of the condition.

4. In the Order to Execute section of the dialog, set the
parameters of the order you would like entered when the
condition is met, including the volume and volume type, price
and price type, symbol, and expiration. You will click on an
order button to determine whether the order is a buy or a sell
order.

5. Click on Buy to trigger a buy order or Sell to trigger a sell
order.

Each conditional order is stored on your local computer until the
condition is satisfied. Your local copy of RealTick must be running for the order to be sent. If a conditional order is set and
the condition is satisfied while the local copy of RealTick is closed, the order will not be sent to the appropriate exchange

Basket Orders
RealTick allows you to trade “baskets” of securities as if you
were trading a single instrument or an index.  You can configure a
Market Minder window to group the symbols together, weight
them, and trade the resultant basket using a special appended
basket order entry screen.  A basket order may include both buy
and sell orders.  This feature may not be available for all trading
customers.

� To set up a Basket Minder:
6. Select Market Minder from the Design menu.
7. In the Minder Setup dialog, check the Trade Baskets

checkbox in the lower right corner.
8. Click on the Select Account button and select the account you use for trading in the Select Account dialog box.
9. Load a symbol list and edit it in the Selected Symbols area, or enter the desired symbols individually until you have

all the symbols you want to include in your basket.  Click on OK.  A Basket Minder window should appear with the
Basket Order Screen at the bottom.  If the Basket Order Screen does not appear, right-click in the Basket Minder and
click on Show Basket Order Screen in the pop-up menu.

10. The Basket Minder has a few special columns in its layout, including Weight, Execute, Cost, and Basket Pos.  You
can add and delete columns using the Column Layout dialog box as for any Minder window.

11.  You must enter a weight for each symbol in your basket.  The weight is the number of shares of that instrument
ordered for each full basket.  A positive number implies a buy order; a negative number implies a sell order.  Double
click on the Weight column in the first row, type in a number, and hit Enter.  Repeat this process for each symbol.
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12. When you are satisfied with the list of symbols and the weight of each symbol, save your basket by right-clicking
in the Basket Minder and choosing Save Basket from the popup menu.  In the Save As dialog box, give your
basket file a name, such as silicon.bkt.  You can then load the basket into any Basket Minder on any page.  Be sure
to save your basket file, even if you created the basket from a pre-existing symbol file.  The symbol file will contain
only the symbols, while the basket file will contain the weights assigned to each symbol as well as the symbols
themselves.

13. You must, of course, save the current page to save the Basket Minder on that page.
Once your Basket Minder is set up and saved, you can trade the entire basket of instruments quickly and easily using the
Basket Order Screen at the bottom of your window.

Delta Orders and Target Orders
There are two types of basket orders, the Delta order and the Target order.  A Delta order ignores your current positions
and orders the weight of each symbol in your basket multiplied by the Delta setting.  A Target order takes your current
positions into account when calculating the number of shares of each symbol needed.  The Basket Minder will calculate
buy and/or sell orders so that you reach a position equal to the target weight.  If you enter a Target order of 1 including
stock XYZ with a weight of 1000, your current position in stock XYZ will determine the order placed.  In this case, if your
position in stock XYZ is 1200, you will sell 200 shares of XYZ; if your position in stock XYZ is 500, you will buy 500
shares of XYZ.

Target orders can be used in several ways.  First, you can use a Target order to follow up on a Delta order.  If your Delta
order was only partially filled, a Target order for the same amount will order the remaining shares.  Second, Target ordering
allows you to change strategies midway through a basket execution.  You may start out with a conservative basket
strategy, placing buys below the current offer or sells above the current bid.  If you decide to trade more aggressively
with the remaining basket orders, merely cancel the outstanding basket orders, change the order parameters, and execute
the basket again.  Orders at the new price level will only be placed for the portions that were not filled the first time.  This
strategy can be repeated until all the securities have reached their basket targets.  Third, Target orders may be used to
pursue a dollar neutral strategy, redistributing the capital you have in the market without investing additional funds.  The
Estimate Target button simplifies this procedure.  Once you have entered the symbols and weights you wish your
positions to achieve, the Estimate Target button considers your current positions and creates a balanced group of sell
and buy orders with roughly the same value.  These orders will progressively move your position closer to your goal
without requiring large amounts of additional buying power.

Sending Basket Orders
As in any order entry form, you should check the Order Parameters in your Basket Minder, including the price type,
volume type, route, and expiration settings.  You can set the default parameters for NASDAQ and listed securities
separately using the NASDAQ Orders and Listed Orders sections of the order entry form.  The Short Sell checkbox must
be selected for short sale orders.  To position a bid or offer relative to the spread, select Bid/Offer and then choose a
setting from the drop-down listbox to the right (Current Market, 1 Tick Better, 1 Tick Worse, 2 Ticks Better, or 2 Ticks
Worse).  If you are sending a large order and would like it to appear in the market as a series of smaller orders, select
Managed Order and set the amount of each smaller order in the Amount to Show box.

When you have configured the parameters of your basket order, you must calculate the cost before you can send the
order to the market.

� To send a Delta Order:
1. Select Delta at the bottom left of your Basket Order screen.  Enter the number of baskets you would like to order in

the textbox to the right.  If you set Delta to 1 you will order 1 X the weight of each instrument (negative numbers
imply sell orders; positive numbers imply buy orders).  If you set Delta to 2 you will order 2 X the weight of each
instrument, or 2 full baskets.  If you set Delta to –1 you will order –1 X the weight of each instrument.  When you
enter orders with negative Delta settings you will sell instruments with positive weights and buy instruments with
negative weights.

2. Click on Recalculate to calculate the cost of the entire order.
3. Check the Execute Details column to see a textual representation of the order that will be placed for each security

when the basket is executed.
4. Click on Execute Trade to send the order to the market.
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� To send a Target order:
1. Select Target at the bottom left of your Basket Order screen. Enter the number of baskets you would like to have in

your portfolio in the textbox to the right.
2. Click on Recalculate to calculate a plain Target order, with your current positions subtracted from the weights to

calculate the order, OR
3. Click on Estimate Target to calculate a dollar neutral Target amount, with buy and sell orders of roughly the same

value so that you do not require large amounts of additional buying power to execute the basket trade.  Then click
on Recalculate to calculate the actual amounts of the order.

4. Click on Execute Trade to send the order to the market.
Once your basket order has reached the market, the Basket Minder will show you the number and cost of your buy and
sell orders and the total cost of your basket order in the Basket Statistics area at the bottom of the screen.

Advanced Basket Trading:  Limiting Exposure
If you are using additional buying power to place Target orders, you can still limit your exposure, keeping the cost of the
orders below a set limit and balancing the basket.  You have two options for limiting exposure:  Partition (orders the full
amount of each instrument in the basket in order until the dollar limit is reached) and Slice (divides the dollar amount
among all the instruments in the basket and orders a proportional number of each instrument).
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Either method of limiting exposure generally results in multiple executions.  These features are only available for Target
orders.  Partitioning a Basket order sends orders for only some of the securities in the basket, ordering the entire amount
for the selected securities.  If you are selling as well as buying, the cost of buys is balanced with the cost of sells in each
execution when possible, allowing “dollar neutral” strategies.  Slicing a Basket order sends orders for all the securities in
the basket, dividing the overall limit amount by the cost of the buys and sells.  After each Sliced basket execution is
completed, each security in the basket should have made equal progress toward its target position.  If you Slice your
Basket orders, you may incur higher transaction costs because you may place many more orders than if you Partition the
same Basket orders.  Note that Sliced Basket orders may include execute amounts that are not round lots.  This can cause
problems if the exchange does not support odd lot trading.  The Basket Minder will attempt to round off the execute
amount to the nearest 100 as applicable.

� To trade baskets with limited exposure:
1. Select Target in the Basket Quantity area and enter the number of baskets desired.
2. In the Advanced Options area, check Limit Exposure.
3. Enter the amount corresponding to your limit.
4. Choose Partition Rows or Slice Shares as desired.
5. Click on Estimate Target to calculate the order.
6. Check the order information in the Execute Details column.
7. If the Execute Details information is correct, click on Execute Trade to send the order to the exchange.

Canceling Orders
If you wish to cancel an order that has been sent to the exchange but not yet filled, you can do it from your Order Minder,
from your Position Minder, or from the Order Entry Screen.  If you have enabled Confirm All Trades in the Options tab of
the Order Entry Properties dialog, RealTick will confirm cancellations as well as orders.

Canceling Orders from an Order Minder
The Cancel Orders Popup menu appears when you right click on a value in the Status column of the Order Minder
window.  This menu allows you to cancel the pending order that you selected, or to cancel all pending orders in the
account.

� To cancel an order in the Order Minder:
1. Right-click inside the Status column of the LIVE order that you want to cancel.
2. Select Cancel Order from the Popup menu.

Canceling Orders from a Position Minder

� To cancel an order in the Position Minder:
1. Right click inside the Status column of the LIVE order that you want to cancel.
2. Select Cancel Order from the popup menu.

Canceling Orders from the Order Entry Screen
There are three ways to cancel a pending order from the Order Entry Screen.  You can cancel the remainder of an order
that has partially filled or the entirety of an order that has not yet filled.  The Cancel Now!! and Cancel Order can both be
found in the upper panel popup menu.  Right-click over a pending order to access these two commands.  Cancel Now!!
cancels the pending order immediately, while Cancel Order opens the Cancel Order dialog box.  Be aware that if you have
enabled Confirm All Trades in the Options tab of the Order Entry Properties dialog box, RealTick will confirm (or reconfirm,
if you use Cancel Order) your cancellation orders as well as your other orders.

� To double-click and cancel an order in the Order Entry Screen:
1. Open the OES Setup dialog box by selecting Setup from the Order Entry menu.
2. Click on Quick Double-Click Cancels, then click on OK to close the Setup dialog and save the new setting.
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3. Double-click on a pending order (red text) in the upper panel to cancel it.  If Confirm All Trades is not enabled,
the order will be cancelled immediately.

4. If Confirm All Trades is enabled in the Options tab of the Order Entry Properties dialog box, a confirmation
dialog will appear.  Click on OK to cancel the order.

� To cancel using Cancel Now!! in the Order Entry Screen:
1. Right-click on a pending order (red text) in the upper panel.
2. Click on Cancel Now!!  If Confirm All Trades is not enabled, the order will now be cancelled.
3. If Confirm All Trades is enabled in the Options tab of the Order Entry Properties dialog box, a second

confirmation dialog will appear.  Click on OK to cancel the order.

� To double-click and cancel an order in the Order Entry Screen:
1. Right-click on a pending order (red text) in the upper panel.
2. Click on Cancel Order.
3. The Cancel Order dialog box will appear.
4. Check the parameters quickly, and if it is the correct order, click on Cancel Order.  If Confirm All Trades is not

enabled, the order will now be cancelled.
5. If Confirm All Trades is enabled in the Options tab of the Order Entry Properties dialog box, a second

confirmation dialog will appear.  Click on OK to cancel the order.

Regulations

SOES Five Minute Rule
Townsend Analytics, Ltd. interprets the SOES five-minute rule in the following manner:

The same decision-maker cannot order more than one thousand shares of the same instrument (showing the same action
(buy or sell) and the same account) within a five-minute period.  The 5-minute rule is enforced on a user-by-user basis.

Even though Townsend Analytics, Ltd. provides a way to administer this particular SOES rule, Townsend Analytics, Ltd.
is not responsible for its enforcement.  It is the responsibility of your broker/ dealer to administer and enforce exchange
regulations.

Short Sale/Downtick Rule
Note:  Although this manual provides some information about exchange regulations and the enforcement thereof, it is not
the responsibility of Townsend Analytics, Ltd. to administer or enforce exchange regulations.  It is the responsibility of
your broker/dealer to administer and enforce exchange regulations.  For more information, contact the exchange on which
you wish to trade.

RealTick interprets short sale/downtick rules in the following manner:

SOES

The trader cannot sell short on a downtick as indicated by the direction of the bid.  The SOES system will automatically
monitor the Bid indication and reject any sell short order when the Bid is down.

SelectNet
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The SelectNet system does not monitor the Bid indicator and as such does not automatically enforce the down tick rule.
The RealTick order entry system will enforce the down tick rule for orders entered in the SelectNet system in the following
manner:

When the current Bid direction indicator is down, RealTick will reject an offer to sell short at a limit price equal to or less
than the current bid price for the security.  RealTick will accept an offer to sell stock short at least 1/16 above the current
Bid.

Island

The Island ECN does not monitor the Bid indicator and as such does not automatically enforce the down tick rule.  The
RealTick order entry system will enforce the down tick rule for orders entered in the Island ECN in the following manner:

When the current Bid direction indicator is down, RealTick will reject an offer to sell short at a limit price equal to or less
than the current bid price for the security.  RealTick will accept an offer to sell stock short at least 1/16 above the current
Bid.

Archipelago

The Archipelago ECN monitors the Bid indicator and will automatically enforce the down tick rule:

When the current Bid direction indicator is down, Archipelago will post the short 1/16th above the Bid.

Listed Exchanges (NYSE and AMEX)

The trader cannot sell short on a down tick as indicated by
the direction of the last trade.  The NYSE and AMEX stock
exchanges automatically monitor the last trade indication and
reject any sell short order when the last trade is down.

Administration

The Order Entry Screen  (OES)
The upper panel of the Order Entry Screen displays
transaction information, with the transactions listed in the
order in which they were sent to the exchange.  The lower panel allows you to configure and send orders.  We do not
recommend that you use the Order Entry Screen by itself to send orders.  You should add the order entry screen to a
MarketMaker and set the parameters of your order there before sending it to the exchange.  However, the Order Entry
Screen itself is useful for viewing your trading history and for troubleshooting.
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OES Upper Panel
The Order Entry Screen upper panel displays all your orders for all accounts and all exchanges, the status of each order,
and the actions taken on each order at the exchange.  The upper panel can show either a simple display consisting of only
the order and the resulting action on the exchange, or a detailed display consisting of every action taken on each order
from its placement to its termination at the exchange.  The simple display is called Order Book View.  This is the default
display for the Order Entry Screen Upper Panel.  The detailed display is called Historic View.  Switch between the two
views using the Order Entry setup dialog:

� To switch between Order Book View and Historic View:
1. Right-click inside the Order Entry Screen upper panel.
2. Select Setup from the popup menu.  The Setup dialog box will open.
3. Select the appropriate view in the Order Display section.

• If you select Summary, only the result of each order will be shown (Bought 500 MSFT at 75, or Close CSCO
position on TALX).

• If you select Standard Detail, the original order and the resulting action at the exchange will be displayed.

• If you select Full Detail, every action taken on your order from its placement to the exchange will be displayed.
The upper panel of the Order Entry Screen initially displays three columns:  Time, Action Taken, and Result. (To see the
six-column layout, right-click in the Order Entry window and select Reset Columns from the popup menu.)  You can size
the upper panel columns as you would size columns in any RealTick screen.  Size the Order Entry Screen and columns so
that the upper panel displays all of the pertinent information.

OES Lower Panel
The lower panel of the Order Entry Screen is the same window that appears when you trade from a MarketMaker or
Market Minder window.  It allows you to configure and send orders.  We do not recommend that you use the Order Entry
Screen by itself.  Use the Order Entry capabilities of the MarketMaker or Market Minder windows instead. The lower
panel of the OES can be removed to save screen real estate by hitting F7 or by selecting Show Order Entry Screen from
the upper panel popup menu.

Order Entry Screen Popup Menus
The Order Entry Screen has several popup menus that appear when you right-click inside an area of the Order Entry
Screen.

• Right-click anywhere inside the upper panel to see the Order History popup menu.  You can view, change
and cancel your orders with this menu.  You can set your order entry properties, change the fonts for your
Order History window, select accounts for trading, and reset the upper panel columns.

• Right-click on an Order Button to see the Order Button Configuration popup menu, which lets you
configure the action of each button.  Select the action (buy or sell), the exchange, and the order duration (IOC,
GTC or Day).

• Right-click anywhere inside the lower panel for an abbreviated popup menu.

Troubleshooting with the Extended Details window
The Order Entry Screen includes a useful troubleshooting feature.  If you have a problem
or need to question an order or a fill, call up your Order Entry Screen.  Find the record of
the order in the top half of the Order Entry Screen.  Double-click on it (or right-click and
choose the command View Order with the unique ID number of that order) to open the
Extended Details window.  This window contains the information your system
administrator will need to answer your question regarding that order or fill, including the Order ID, Transaction ID,
Remote ID, and all the original order information.
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End of Day Reporting
RealTick creates a daily log of trades which is stored in your \data directory.  RealTick must be running when all execution
notifications are received.  If an execution notification arrives while RealTick is not running, the trade will not appear in
the daily trade log.  You can open this file in Microsoft Excel to facilitate end of day reporting.  The end of day log file
name begins with TRD, followed by the date in the format mmdd, followed by a “.CSV” filename extension (e.g.
TRD1215.CSV).

Logging
By default, RealTick sends a record of each action to a global log file, which is stored in your \data directory.  The log file
name begins with lpt, followed by the date in the format mmdd, followed by a “.log” filename extension  (e.g. lpt0915.log).
The Order Entry log file records every order and every action taken on your order during the trading day.  Your system
administrator may need to access this information to solve technical difficulties.

If you wish, you can print this log using a printer connected directly to your machine.  Be aware that this will slow the
performance of your system.

� To log orders to your printer:
1. Choose Order Entry Properties from the menu of any order entry-enabled window.
2. Select the Options tab in the Order Entry Properties dialog box.
3. Click on the Configure Logging button.  The Configure Logging dialog box will appear.
4. Select the port to which your printer is connected from the Printer drop-down list box.
5. Click on OK.  RealTick will now send a record of each order to your printer.

After Hours Order Entry
Although the market closes at 4:00 p.m. Eastern time, there are after-hours opportunities to trade.  Not all broker-dealers
accept after-hours trades, however.  Please ask your broker-dealer what after-hours options you have.

Demo Capabilities
When you log in to RealTick, you are ready to trade.  There is no separate demo mode.  If you want to demonstrate
RealTick, or if you simply want to practice with RealTick before entering any live orders, you must use TALX, Townsend
Analytics, Ltd.’s practice exchange.  You must have your System Administrator set up a mock account for you that only
enables you to access TALX to use the practice exchange.
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